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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licens-
es.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Caution:

Use of controls or adjustments or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.
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Manuals for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

Important
❒ Media differ according to manual.
❒ The printed and electronic versions of a manual have the same contents.
❒ Adobe Acrobat Reader/Adobe Reader must be installed in order to view the

manuals as PDF files.
❒ Depending on which country you are in, there may also be html manuals. To

view these manuals, a Web browser must be installed.

❖ About This Machine
Be sure to read the Safety Information in this manual before using the ma-
chine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

❖ General Settings Guide
Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.

❖ Troubleshooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, and other consumables.

❖ Security Reference
This manual is for administrators of the machine. It explains security func-
tions that you can use to prevent unauthorized use of the machine, data tam-
pering, or information leakage.
For enhanced security, we recommend the following settings.
• Install the Server Certificate.
• Enable SSL(Secure Sockets Layer) Encryption.
• Change the user name and password of the administrator using Web Im-

age Monitor.
For details, see “Setting Up the Machine”, Security Reference.
Be sure to read this manual when setting the enhanced security functions, or
user and administrator authentication.

❖ Copy Reference
Explains Copier functions and operations. Also refer to this manual for expla-
nations on how to place originals.

❖ Facsimile Reference
Explains Facsimile functions and operations.
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❖ Printer Reference
Explains Printer functions and operations.

❖ Scanner Reference
Explains Scanner functions and operations.

❖ Network Guide
Explains how to configure and operate the machine in a network environ-
ment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.

❖ Other manuals
• Manuals for This Machine
• Safety Information
• Quick Reference Copy Guide
• Quick Reference Fax Guide
• Quick Reference Printer Guide
• Quick Reference Scanner Guide
• PostScript 3 Supplement
• UNIX Supplement
• Manuals for DeskTopBinder Lite

• DeskTopBinder Lite Setup Guide
• DeskTopBinder Introduction Guide
• Auto Document Link Guide

Note
❒ Manuals provided are specific to machine types.
❒ For “UNIX Supplement”, please visit our Web site or consult an authorized

dealer.
❒ “PostScript3 Supplement” and “UNIX Supplement” include descriptions of

functions and settings that might not be available on this machine.
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates important safety notes. 
Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information” section of About This Ma-
chine.

Indicates important safety notes. 
Ignoring these notes could result in moderate or minor injury, or damage to the
machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.
[ ]
Indicates the names of keys that appear on the machine’s display panel.
{ }
Indicates the names of keys on the machine’s control panel.
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Display Panel

This section describes configuration using the display panel when the printer
function is selected.

1. Operational status or messages
Displays current machine status, such as
“Ready”, “Offline”, and “Please
wait...”.

2. [JobReset]
Press to cancel the current print job. If
you press it when the machine is offline
and Hex Dump is selected, Hex Dump is
canceled.

3. [Menu]
Press to display the menu to select the
following options:

• [FormFeed]
Press to print all the data left in the
machine's input buffer.

• [Error Log]
Displays the error logs of print jobs
that are sent from a computer.

Note
❒ When the power is turned on, the copier display is shown. This is a factory

default. This initial setting can be changed. See “System Settings”, General
Settings Guide.

ASC009S
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Reading the Display and Using Keys

This section explains how to read the display and using the selection key for the
initial display.

1. Scroll keys
Press to move the cursor in each direc-
tion, step by step.
When the {U}, {T}, {V}, or {W} key ap-
pears in this manual, press the scroll key
of the same direction.

2. {OK} key
Press to set a selected item or entered nu-
meric value. 

3. {Escape} key
Press to cancel an operation or return to
the previous display.

4. Selection keys
Correspond to the function items at the
bottom line on the display. Example: Ba-
sic screen When the instruction “press
[JobReset]” appears in this manual, press
the left selection key.

ASC004S
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Printer Features Menu

The following explains settings and meanings of functions on Printer Feature.
Printer Feature screen appears when you press the {User Tools/Counter} key. For
details, see “Printer Features”, General Settings Guide.

❖ List/Test Print

❖ Maintenance

Menu Description

Multiple Lists You can print the configuration page and er-
ror log.

Config. Page You can print the machine's current configu-
ration values.

Error Log You can print error logs listing all errors that 
occurred during printing. 

Menu List You can print a Menu List showing the ma-
chine's function menus.

PCL Config./Font Page You can print the current configuration and 
installed PCL font list.

PS Config./Font Page You can print the current configuration and 
installed PostScript font list.

PDF Config./Font Page You can print the current configuration and 
installed PDF font list.

This menu can be selected only when the op-
tional PostScript 3 unit is installed.

Hex Dump You can print in the Hex Dump mode.

Menu Description

Menu Protect This function lets you protect menu settings 
from accidental change. It makes it impossi-
ble to change menu settings with normal 
procedures unless you perform the required 
key operations. 

In a network environment, only administra-
tors can make changes to menu settings.

List/Test Print Lock You can lock the [List/Test Print] menu.
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❖ System

Menu Description

Print Error Report You can print an error report when a printer 
or memory error occurs.

Auto Continue You can select this to enable Auto Continue. 
When it is On, printing continues after a sys-
tem error occurs.

Memory Overflow Select this to have a memory overflow error 
report printed.

Job Separation You can enable Job Separation.

This menu can be selected only when a fin-
isher (optional) is installed.

Memory Usage You can select the amount of memory used 
in Font Priority or Frame Priority, according 
to paper size or resolution.

Duplex You can select to have print on both sides of 
each page.

Copies You can specify the number of print sets. 
This setting is disabled if the number of pag-
es to print has been specified with the printer 
driver or another command.

Blank Page Print You can select whether or not to print blank 
pages.

Edge Smoothing Set this to enable Edge Smoothing.

• On (Default)

• Off

If Toner Saving is set to On, Edge Smoothing 
is ignored even if it is set to On.

Toner Saving Set this to enable Toner Saving.

• On (Default)

• Off

Printer Language You can specify the printer language.

Sub Paper Size You can enable the Auto Substitute Paper 
Size (A4↔LT) feature.

Page Size You can select the default paper size.

Letterhead Setting You can rotate original images when print-
ing.

When printing, original images are always 
rotated by 180 degrees. Therefore, output 
might not be as expected when printing onto 
letterhead or preprinted paper requiring ori-
entation. Using this function, you can specify 
image rotation.

Bypass Tray Priority You can specify which of the two options, 
(Printer) Driver / Command or Machine Set-
tings, has priority for determining the paper 
size for the bypass tray.
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❖ Host Interface

❖ PCL Menu

Edge to Edge Print You can select whether or not to print on the 
entire sheet.

Default Printer Lang. You can set the default printer language if 
the machine cannot find the printer language 
automatically.

Tray Switching You can set to switch the paper tray.

RAM Disk You can change the settings of the RAM disk.

Menu Description

I/O Buffer You can set the size of the I/O Buffer. Nor-
mally it is not necessary to change this set-
ting.

I/O Timeout You can set how many seconds the machine 
should wait before ending a print job. If data 
from another port usually arrives in the mid-
dle of a print job, you should increase this 
timeout period.

Menu Description

Orientation You can set the page orientation.

Form Lines You can set the number of lines per page.

Font Source You can set the storage location of the de-
fault font.

Font Number You can set the ID of the default font you 
want to use.

Point Size You can set the point size you want to use for 
the selected font.

Font Pitch You can set the number of characters per 
inch for the selected font.

Symbol Set You can specify the set of print characters for 
the selected font. The available options are as 
follows:

Courier Font You can select a courier font type.

Ext. A4 Width You can extend the printing area width 
when printing on A4 sheet with PCL.

Append CR to LF When set to On, a carriage return will follow 
each line feed: CR=CR, LF=CR−LF, FF=CR−
FF.

Resolution You can set the print resolution in dots per 
inch.

Menu Description
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❖ PS Menu (optional) 

❖ PDF Menu (optional)

Note
❒ Depending on which optional units you have installed or the printer lan-

guage you have selected, some options are not displayed.
❒ Depending on the security settings, you might not be able to set certain op-

tions.

Reference
For details, see “Printer Features”, General Settings Guide.
For more information about copier features and system settings, see Copy
Reference and General Settings Guide.

Menu Description

Data Format You can select a data format.

Resolution You can set the print resolution in dots per 
inch.

Menu Description

Change PDF Password You can set the password for the PDF file ex-
ecuting PDF Direct Print.

PDF Group Password You can set the group password already 
specified with DeskTopBinder Lite.

Resolution You can set the print resolution in dots per 
inch.
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Setting Paper on the Bypass Tray

This section gives instructions for setting paper on the bypass tray.
For details about paper size and paper type, see “Recommended Paper Sizes and
Types”, About This Machine.

Important
❒ The following functions are disabled when printing from the bypass tray:

• Duplex printing
• Auto Tray Select
• Auto Tray Switching
• Rotating Collate
• Staple (when the finisher installed)

❒ When printing using the printer function, original images are always rotated
by 180 degrees (the orientation of images to be printed is opposite to that of
the copier function). When printing onto paper with specific orientation re-
quirements, such as envelopes and letterheads, be sure to rotate the paper
feed orientation to 180 degrees.

❒ Be sure to set the paper size using the printer driver when printing data from
the computer. The paper size set using the printer driver has priority over the
one set using the control panel.

❒ Paper that is thicker than 162 g/m2 (max.) cannot be printed from the bypass
tray.

A Open the bypass tray.

BAE001S
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B Lift up the paper guide release lever.

1. Paper guide release lever

C Adjust the paper guides to the paper size, and then gently insert paper face
down into the bypass tray.

1. Extender

2. Paper guides
• Open out the extender to support paper sizes larger than A4 L, 81/2 ×11 L.
• If the paper guides are not flush against the paper, skewing and misfeeds

might occur.
• Gently insert paper until it stops.
• Load only as much paper as can be held between the guides on the bypass

tray. Overloading the bypass tray can result in misfeeds and skewed imag-
es. 

• Fan the paper to get air between the sheets to avoid a multi-sheet feed.
• When setting an OHP transparency, make sure that its front and back sides

are properly positioned.

ARB017S

AYM004S
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D Push down the paper guide release lever.

E Set the paper size using the printer driver or the control panel.

Note
❒ Paper within the following dimensions can be set in the bypass tray:

• Vertical: 90 - 297 mm (3.55 - 11.69 in.)
• Horizontal: 148 - 600 mm (5.83 - 23.62 in.)

❒ Be sure to set the paper with the side you want to print facing down in the
bypass tray.

❒ The number of sheets that can be loaded in the bypass tray depends on the
paper type.

❒ When loading OHP transparencies or thick paper in the bypass tray, make
the paper setting using the control panel or printer driver.

Reference
For details about setting the paper size, see p.11 “Setting the Paper Size Us-
ing the Control Panel”.
For details about setting paper in the regular paper tray, see Copy Refer-
ence and General Settings Guide.
When loading custom size paper, see p.12 “Setting the Custom Size Paper
Using the Control Panel”.
Select paper type when printing onto OHP transparencies or thick paper
(over 105.1 g/m2). For details, see p.14 “Setting Thick Paper or OHP Trans-
parencies Using the Control Panel”.
Select paper type when printing onto envelopes. For details, see p.15 “Set-
ting Envelope Using the Control Panel”.
When loading letterhead paper, pay attention to its orientation. See Copy
Reference and General Settings Guide.

AYM005S
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Setting the Paper Size Using the Control Panel

This procedure describes how to set paper size of the bypass tray using the con-
trol panel. If you select the printer driver to set paper size, this procedure is not
necessary.

A Press the {User Tools/Counter} key. 

B Select [System Settings] using {T} or {U}, and then press the {OK} key.

C Select [Tray Paper Settings] using {T} or {U}, and then press the {OK} key. 

D Select [Printer Bypass Paper Size] using {T} or {U}, and then press the {OK}
key. 

E Select the paper size using the scroll keys, and then press the {OK} key. 

F Press the {User Tools/Counter} key to return to the default screen.

ACS003S
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Reference
See the printer driver Help about the settings from the printer drivers.
Select paper type when printing onto OHP transparencies or thick paper.
For details, see p.14 “Setting Thick Paper or OHP Transparencies Using the
Control Panel”.
Select paper type when printing onto envelopes. For details, see p.15 “Set-
ting Envelope Using the Control Panel”.

Setting the Custom Size Paper Using the Control Panel

The following procedures are not required if you select the printer driver for the
settings. In that case, set the paper size using the printer driver.

Important
❒ Custom size settings set using the printer driver have priority over those set

using the machine's control panel.
❒ When the printer driver is not used, make settings using the control panel.

A Press the {User Tools/Counter} key. 

B Select [System Settings] using {T} or {U}, and then press the {OK} key.

C Select [Tray Paper Settings] using {T} or {U}, and then press the {OK} key. 

ACS003S
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D Select [Printer Bypass Paper Size] using {T} or {U}, and then press the {OK}
key. 

E Select [Custom Size] using the scroll keys, and then press the {OK} key.

F Enter the horizontal size of the paper using the number keys, and press
{q}. 
Available size: 148 - 600 mm (5.83 - 23.62 in.)

G Enter the vertical size of the paper using the number keys, and press {q}. 
Available size: 90 - 297 mm (3.55 - 11.69 in.)

H Press the {User Tools/Counter} key to return to the default screen.

Note
❒ If the printer driver is not used, select [Machine Settings] from [Bypass Tray

Priority] in [System] of [Printer Features] (see “Printer Features”, General Set-
tings Guide). Set paper size using the control panel.

Reference
For printer driver settings, see the printer driver Help.
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Setting Thick Paper or OHP Transparencies Using the Control 
Panel

The following procedures are not required if you select the printer driver for the
settings. In that case, set the paper size using the printer driver.

Important
❒ Paper size settings set using the printer driver have priority over those set us-

ing the machine's control panel.
❒ When the printer driver is not used, make settings using the control panel.

A Press the {User Tools/Counter} key. 

B Select [System Settings] using {T} or {U}, and then press the {OK} key. 

C Select [Tray Paper Settings] using {T} or {U}, and then press the {OK} key. 

D Select [Paper Type: Bypass Tray] using {T} or {U}, and then press the {OK}
key.

ACS003S
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E Select paper type from the menu using {T} or {U}, and then press the {OK}
key.

F Press the {User Tools/Counter} key to return to the default screen.

Note
❒ The settings made will remain valid until they are reset again. After print-

ing on thick paper or OHP Transparencies, be sure to clear settings for the
next user.

Reference
For the printer driver settings, see the printer driver Help.
For details about printing onto envelopes, see p.15 “Setting Envelope Us-
ing the Control Panel”.

Setting Envelope Using the Control Panel

A Press the {User Tools/Counter} key.

B Select [System Settings] using the {U} or {T} key, and then press the {OK}
key.

C Select [Tray Paper Settings] using the {U} or {T} key, and then press the {OK}
key.

D Select [Paper Type:Bypass Tray] using the {U} or {T} key, and then press the
{OK} key.
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E Select [Thick Paper] using the {U} or {T} key, and then press the {OK} key.

F Select [Printer Bypass Paper Size] using the {U} or {T} key, and then press the
{OK} key.

G Select the paper envelope size, and then press the {OK} key.

H Press the {User Tools/Counter} key to return to the default screen.
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Confirming the Connection Method

This machine supports network and local connection.
Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using This Machine as the Windows Printing port

Network connections can be established through Ethernet and IEEE 802.11b.
Available ports are determined based on the combination of Windows operating
system version and connection method used.

❖ Windows 95 / 98

❖ Windows Me

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

BAE003S
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❖ Windows 2000/Windows XP/Windows Server 2003

❖ Windows Vista

❖ Windows NT 4.0

Reference
See the explanation about how to install the printer driver for each type of
port. For the SmartDeviceMonitor for Client port, see p.24 “Using the Smart-
DeviceMonitor for Client Port”.
For the Standard TCP/IP port, see p.30 “Using the Standard TCP/IP Port”.
For the LPR port, see p.32 “Using the LPR Port”.
For details about installation under Windows Vista, see p.22 “Installing the
Printer Driver under Windows Vista”.

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

Connection Method Available Ports

Ethernet / IEEE 802.11b Standard TCP/IP

LPR port

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

LPR port
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Using as a network printer

This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Note
❒ In an IPv6 environment, Netware servers cannot be used.

Reference
See the explanation about how to install the printer driver for each type of
network printer. 
For the Windows network printer, see p.34 “Using as a Windows Network
Printer”.
For the NetWare print server and remote printer, see p.37 “Using as a Net-
Ware Print Server / Remote Printer”.
For details about installation under Windows Vista, see p.22 “Installing the
Printer Driver under Windows Vista”.

BAE004S



Preparing the Machine

20

1

Local Connection

Local connections can be established via parallel, USB, and Bluetooth connec-
tions.
Windows operating system version determines the available connection meth-
ods.
• Windows 95:

Parallel connections
• Windows 98:

Parallel connections
• Windows 98 SE / Me:

USB and Parallel connections
• Windows 2000:

USB, Parallel, and Bluetooth connections
• Windows XP:

USB, Parallel, and Bluetooth connections
• Windows Server 2003:

USB, Parallel, and Bluetooth connections
• Windows Vista:

USB and Parallel connections
• Windows NT 4.0:

Parallel connections

Reference
See the explanation about how to install the printer driver for each method of
connection. 
For the USB connection, see p.40 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.45 “Printing with Parallel Connection”.
For the Bluetooth connection, see p.47 “Printing with Bluetooth Connection”.
For details about installation under Windows Vista, see p.22 “Installing the
Printer Driver under Windows Vista”.
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Installing the Printer Driver

This section explains how to install the printer driver. There are two ways to in-
stall the printer driver: using Quick Install, which installs the settings at once, or
installing the appropriate driver according to the port you want to use.

Important
❒ The printer driver for Windows NT 4.0 is not included on the supplied CD-

ROM. If your operating system is Windows NT4.0, download printer driver
for Windows NT4.0 from the supplier's Web site. For details, ask your
sales/service representatives.

Quick Install

Windows 95 / 98 / Me / 2000 / XP and Windows Server 2003 users can easily
install this software using the supplied CD-ROM.
Using Quick Install, the PCL printer driver and/or RPCS printer driver, Desk-
TopBinder Lite and SmartDeviceMonitor for Client are installed under network
environment, and the TCP/IP port will be set.

Important
❒ To install printer driver under Windows 2000 / XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrator.

❒ If you connect using USB, refer to p.40 “Installing the Printer Driver Using
USB” and install the printer driver.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts. 
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.

E After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the machine model you want to use in the [Select Printer] dialog box.
For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].
For parallel connection, select the machine whose printer port is displayed in
[Connect To].
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G Click [Install].
The printer driver installation starts. 

H Click [Finish].
A message about restarting the computer appears. Restart the computer to
complete installation.

I Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Select a machine to whose IP address is displayed in [Connect To] to install

SmartDeviceMonitor for Client when using TCP/IP.

Reference
Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.51 “If
Bidirectional Communication Is Disabled” for details about bidirectional
communication between the machine and computer.

Installing the Printer Driver under Windows Vista

Use the following procedure to install and set up the printer driver under Win-
dows Vista.

Important
❒ The printer driver Help cannot be displayed on computers running Windows

Vista.
❒ SmartDeviceMonitor for Client cannot be installed on computers running

Windows Vista.
Windows Vista users can install the PCL or RPCS printer driver using the sup-
plied CD-ROM.
The printer driver installers can be found in the following locations:
Example (the “D” drive is the CD-ROM drive):
• RPCS

D:\DRIVERS\RPCS\XP_VISTA\(Language)\DISK1

• PCL (PCL5E/PCL6)
D:\DRIVERS\PCL(PCL5E or PCL6)\XP_VISTA\(Language)\DISK1

Install and set up the printer driver as follows:
A Install the printer driver.
B Specify the port settings.
C Configure the properties.
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A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

C Launch the Add Printer Wizard to install the PCL or RPCS printer driver.
Click [Control Panel] on the [Start] menu, click [Hardware and Sound], click [Print-
er], and then click [Add a Printer] to launch the Add Printer Wizard.

D Specify the required port.
You can change the port settings on the [Ports] tab in the printer properties di-
alog box.
For details about the printer properties, see p.23 “Windows Vista - Accessing
the Printer Properties”.
For details about the available ports, see p.17 “Confirming the Connection
Method”.

E Configuring the properties.
If necessary, configure the settings in the printer properties dialog box.
If bidirectional communication has been enabled, the options are automati-
cally configured.
If bidirectional communication has not been enabled, you must configure the
options manually.

Windows Vista - Accessing the Printer Properties

To make the printer default settings, open the printer properties dialog box from
the [Printers] window. 

A On the [Start] menu, point to [Control Panel], and then click [Hardware and
Sound]-[Printer].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [Organize] menu, click [Properties].

D  Make the necessary settings, and then click [OK].

Reference
p.17 “Confirming the Connection Method”
p.50 “Making Option Settings for the Printer”
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Installing the Printer Driver for the Selected Port

Using the SmartDeviceMonitor for Client Port

Important
❒ To install SmartDeviceMonitor for Client under Windows 2000 / XP Profes-

sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

❒ Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

Installing SmartDeviceMonitor for Client

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [DeskTopBinder - SmartDeviceMonitor for Client].

E The message to quit all other applications appears. Quit all applications,
and then click [Next >].

F The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

G Click [Full install] or [Custom Install].
[Full install] installs all required applications: DeskTopBinder Lite and Smart-
DeviceMonitor for Client.
[Custom Install] installs selected applications.

H Follow the instructions on the display and click [Next >] to proceed next
step.

I After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete]. 
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
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Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95 / 98:

A Open the [Printers] window from the [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

A Open [Printers] window from [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C On the [Ports] tab, click [Configure Port].
The [Configuration] dialog box appears.

Windows XP, Windows Server 2003:

A Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

B Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

C Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
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Note
❒ For TCP/IP, timeout setting can be configured.
❒ User, proxy, and timeout settings can be configured for IPP.
❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow the

procedure below.
A Click [Cancel] to close the [Port Configuration:] dialog box.
B Start SmartDeviceMonitor for Client, and then right-click the SmartDe-

viceMonitor for Client icon on the tasktray.
C Point to [Properties], and then click [Extended Features Settings].
D Select the [Set Recovery/Parallel Printing for each port] check box.
E Click [OK] to close the [Extended Features Settings] dialog box.

Reference
For information about these settings, see “Using SmartDeviceMonitor for
Client”, Network Guide, or SmartDeviceMonitor for Client Help.

Installing the PCL or RPCS Printer Driver (TCP/IP)

Important
❒ To install this printer driver under Windows 2000 / XP Professional, Win-

dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.
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I Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

J Click [Port], and then click [Add].

K Click [SmartDeviceMonitor], and then click [OK].

L Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

M Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify address], and then enter the IP address
or host name of the machine.

N Check that the port of the selected printer is displayed in [Port].

O Set a user code, if necessary. 
Up to 8 numeric characters can be entered. No alphabetic character or symbol
can be entered.

P Select the [Default Printer] check box to configure the printer as default.

Q Click [Continue].
Installation starts.

R After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Setting a user code allows a SmartDeviceMonitor for Admin user to dis-

play and check statistics about the number of sheets which each user
prints. For details, see SmartDeviceMonitor for Admin Help. 

❒ Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

❒ Under Windows 95 / 98 / Me, you cannot add an IP address partially sim-
ilar to the one already used. For example, if “192.168.0.2” is in use,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use,
“192.168.0.2” cannot be used. 

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Troubleshoot-
ing.
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Installing the PCL or RPCS Printer Driver (IPP)

Important
❒ To install printer driver under Windows 2000 / XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

I Click [Port], and then click [Add].

J Click [SmartDeviceMonitor], and then click [OK].

K Click [IPP].

L In the [Printer URL] box, enter “http://printer's address/printer” as the print-
er's address.
If the server authentication is issued, to enable SSL (a protocol for encrypted
communication), enter “https://printer's address/printer” (Internet Explor-
er 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http://printer's address/ipp” as the printer's address.
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M Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

N Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

O Click [OK].

P Check that the port of the selected printer is displayed in [Port].

Q Set a user code, if necessary. 
Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

R Select the [Default Printer] check box to configure the printer as default.

S Click [Continue].
Installation starts.

T After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
❒ Setting a user code allows a SmartDeviceMonitor for Admin user to dis-

play and check the number of sheets each user prints. For details, see
SmartDeviceMonitor for Admin Help.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Troubleshoot-
ing.
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Using the Standard TCP/IP Port

This describes how to install the PCL or RPCS printer driver using the TCP/IP
port.

Important
❒ To install this printer driver under Windows 2000 / XP Professional, and

Windows Server 2003, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

Installing the PCL or RPCS Printer Driver

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

J Click [Port], and then click [Add].

K Click [Standard TCP/IP Port], and then click [OK].
Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

L Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
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M Enter the printer name or IP address in the [Printer Name or IP Address] box.
The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When the device selection appears, select “RICOH NetworkPrinter Driver C
Model”.

N Click [Next >].

O Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

P Check that the port of the selected printer is displayed in [Port].

Q Configure the default printer as necessary.

R Click [Continue].
The printer driver installation starts.

S After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Troubleshoot-
ing.
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Using the LPR Port

This describes how to install the PCL or RPCS printer driver using the LPR port.

Important
❒ To install this printer driver under Windows 2000 / XP Professional, Win-

dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

Installing the PCL or RPCS Printer Driver

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Click [Next >].

I Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

J Click [Port], and then click [Add].

K Click [LPR Port], and then click [OK].
If [LPR Port] does not appear, see Windows Help and install it.

L Enter the printer's IP address in the [Name or address of server providing lpd]
box.

M Enter “lp” in the [Name of printer or print queue on that server] box, and then click
[OK].
The port is added.
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N Check that the port of the selected printer is displayed in [Port].

O Configure the default printer as necessary.

P Click [Continue].
The printer driver installation starts.

Q After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Troubleshoot-
ing.
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Using as a Windows Network Printer

This describes how to install the PCL or RPCS printer driver when using the
printer as a Windows network printer.
To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000 / XP, Windows Server 2003, Win-
dows Vista, or Windows NT 4.0 shared printer.
This section assumes that the client has already been configured to communicate
with a Windows 2000 / XP, Windows Server 2003, Windows Vista, or Windows
NT 4.0 print server. Do not begin the following procedure before the client is set
up and configured correctly.

Important
❒ The printer driver for Windows NT 4.0 is not included on the supplied CD-

ROM. If your operating system is Windows NT4.0, download printer driver
for Windows NT4.0 from the supplier's Web site. For details, ask your
sales/service representatives.

❒ To install the printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

❒ If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notifi-
cation functions of SmartDeviceMonitor may not be used with the client. 

❒ The machine’s print server supports computers running Windows Vista,
SmartDeviceMonitor for Client cannot be installed on computers running
Windows Vista.

❒ If you print with a Windows NT 4.0 print server, install the printer driver be-
fore you connect the print server to the printer.

❒ If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.



Using as a Windows Network Printer

35

1

Installing the PCL or RPCS Printer Driver

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the [Printer Name] check box to select the printer models you want to
use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

J Click [Port], and then click [Add].

K Click [Network Printer], and then click [OK].

L Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

M Select the printer you want to use, and then click [OK].

N Check that the port of the selected printer is displayed in [Port].

O Configure the user code as necessary.
For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

P Select the [Default Printer] check box to configure the printer as default.

Q Click [Continue].
The printer driver installation starts.
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R After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Troubleshoot-
ing.
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Using as a NetWare Print Server / Remote 
Printer

This describes how to set up the Windows computer used as the NetWare client.

Important
❒ The printer driver for Windows NT 4.0 is not included on the supplied CD-

ROM. If your operating system is Windows NT4.0, download printer driver
for Windows NT4.0 from the supplier's Web site. For details, ask your
sales/service representatives.

❒ To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

❒ In an IPv6 environment, Netware servers cannot be used.
The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.
Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:
• Operating system: Windows 98
• NetWare version: 4.1
• File server name: CAREE
• Queue name: R-QUEUE

A Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

C Click [PCL/RPCS Printer Drivers].

D The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

E Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

F Click [Next >].
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G Select the [Printer Name] check box to select the printer model you want to
use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

I Click [Port], and then click [Add].

J Click [Network Printer], and then click [OK].

K Double-click the name of the NetWare file server on the network tree.
The created queue is displayed.

L Select the print queue, and then click [OK].

M Check that the port of the selected printer is displayed in [Port].

N Click [Continue].
The printer driver installation starts.

O Click [Finish] in the [Select Program] dialog box.

P After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Q After restarting the computer, launch the [Printers] window, and then open
the printer properties.
Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window.

R On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.
Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.
Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correct-
ly.

S Click [OK] to close the printer properties dialog box.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ The protocol is set to inactive as default. Enable it using Web Image Mon-

itor or Telnet.



Using as a NetWare Print Server / Remote Printer

39

1

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-
er driver on Windows. If NetWare form feed is configured, the printer may not
print properly.
Follow the procedure below to disable form feed according to the operating sys-
tem used:
• Under Windows 95 / 98 / Me, clear the [Form feed] check box on the [Printer

Settings] tab in the printer properties dialog box.
• Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear

the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page.
Follow the procedure below to disable banner pages according to the operating
system used:
• Under Windows 95 / 98 / Me, clear the [Enable banner] check box on the [Print-

er Settings] tab in the printer properties dialog box.
• Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear

the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.
To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.
Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.
The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

Windows Me - USB

Important
❒ Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-

dows Me or later.
❒ Download USB Printing Support for Windows Me from the supplier's Web

site.
When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

A Download USB Printing Support from the supplier's Web site.
Use a search to find the model name, and then download USB Printing Sup-
port from the supplier's Web site.
Save it where you can locate it easily.

B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

C In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

D Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

E Specify the location where USB Printing Support is located, and then click
[Next >].

F Check the location, and then click [Next >].
USB Printing Support is installed.

G Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
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H Install the printer driver. Click [Search for the best driver for your device. [Recom-
mended]], and then click [Next >].

I Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

J Insert the CD-ROM into the CD-ROM drive.

Note
❒ When Auto Run starts, click [Exit].
❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

K Specify the location where the source files of the printer driver are stored,
and then click [Next >].
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1
• PCL 5e

D:\DRIVERS\PCL5E\WIN9X_ME\(Language)\DISK1
• PCL 6

D:\DRIVERS\PCL6\WIN9X_ME\(Language)\DISK1
• PostScript 3 (“Printer Drivers and Utilities” CD-ROM)

D:\DRIVERS\PS\WIN9X_ME\(Language)\DISK1

L Check the location, and then click [Next >].
Add Printer Wizard starts.

M Click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the “USB001” port is added to the [Printers] window.

Note
❒ The number after “USB” varies depending on the number of printers con-

nected.
❒ It is not necessary to reinstall USB Printing Support when connecting a dif-

ferent machine via USB interface when USB Printing Support is installed.
❒ After installing USB Printing Support, if the printer driver is not installed,

follow the plug-and-play instructions of the printer.



Preparing the Machine

42

1

Windows 2000 - USB

Important
❒ Installing a printer driver requires Administrator permission. Log on using

an account that has Administrator permission.
When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

A Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

C Select the [Specify location] check box, and then click [Next >].

D Insert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Exit].
To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

E Specify the location where the source files of the printer driver is stored.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\XP_VISTA\(Language)\DISK1
• PCL 5e

D:\DRIVERS\PCL5E\XP_VISTA\(Language)\DISK1
• PCL 6

D:\DRIVERS\PCL6\XP_VISTA\(Language)\DISK1
• PostScript 3 (“Printer Drivers and Utilities” CD-ROM)

D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

F Check the printer driver location, and then click [OK].

G Click [Next >].

H Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
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Note
❒ The number after “USB” varies depending on the number of printers con-

nected.

Windows XP, Windows Server 2003 - USB

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
The printer drivers can be installed from the supplied CD-ROM provided with
this machine.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

A Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

C Insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].
To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

D Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\XP_VISTA\(Language)\DISK1
• PCL 5e

D:\DRIVERS\PCL5E\XP_VISTA\(Language)\DISK1
• PCL 6

D:\DRIVERS\PCL6\XP_VISTA\(Language)\DISK1
• PostScript 3 (“Printer Drivers and Utilities” CD-ROM)

D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

E Check the printer driver location, and then click [Next >].
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F Click [Continue].

G Click [Finish].
If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers and Faxes] window.

Note
❒ The number after “USB” varies depending on the number of printers con-

nected.
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Printing with Parallel Connection

This describes how to install the PCL or RPCS printer driver when using the par-
allel port.
To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

Important
❒ To install this printer driver under Windows 2000 / XP Professional, Win-

dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

❒ If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

Installing the PCL or RPCS Printer Driver

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the printer driver you want to use in the [Select Program] dialog box. 
You can select several printer drivers.

G Click [Next >].

H Select the [Printer Name] check box to select the printer model you want to
use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

J Check that [LPT1:] is shown in [Port].

K Select the [Default Printer] check box to configure the printer as default.
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L Click [Finish].
The printer driver installation starts.

M After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Troubleshoot-
ing.
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Printing with Bluetooth Connection

This describes how to print using with Bluetooth devices.

Supported Profiles

Refer the following supported profiles for Bluetooth connection.

❖ SPP, HCRP
• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers

can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

• SPP connection does not support bidirectional communications.
• HCRP connection supports bidirectional communications.

❖ BIP
• For BIP connection, a module including PostScript 3 must be installed in

the machine.
• Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-

nected via BIP.
• Only JPEG images that can be printed using BIP.
• User codes are disabled for BIP.

You cannot print if print functions are restricted.
• Some printers do not support BIP.

Note
❒ In this manual, the instruction referred to print using SPP. To print using

HCRP or BIP, see the Help supplied with the Bluetooth adapter you use.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

Important
❒ To install the printer driver under Windows 2000 / XP Professional or Win-

dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

A Start 3Com Bluetooth Connection Manager.
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B Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

C On the [Tool] menu, click [COM port].

D Check that the message “Bluetooth Serial Client (COMx) “ appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

E Click [Close].

F On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

G Click the icon of the printer you want to use.

H On the [File] menu, click [Properties].

I Click the [Ports] tab.

J Under [Port], select the [COMx:] check box. X indicates the COM port number
used by Bluetooth.

K Click [OK].
Close the [Printers] window.

Note
❒ To always use the same printer, select the [Always use for this connection]

check box.
❒ System requirements vary depending on the Bluetooth standard and spec-

ifications. For details, see the manuals supplied with each product.
❒ For information about setting up Bluetooth under other operating systems

or using it with different utilities, see the manuals supplied with those op-
erating systems or utilities.

❒ If a dialog box appears while transmitting a print job, reestablish network
connection as follows:
A Select the printer you want to use in the [Printers and Faxes] box.
B Click [Connect].

Reference
For details, see the manuals supplied with the Bluetooth adaptor or com-
puter equipped with Bluetooth.
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Configuring Security Mode Settings

This describes how to configure the security mode settings.

A Start 3Com Bluetooth Connection Manager.

B On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

C Select the security mode in the [Security Mode:] list.
If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.49 “Printing in the Security Mode”.
For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals supplied with the utility.

D Click [OK].
Close the [Security Mode] dialog box.

Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.49 “Printing in the Security Mode”.

Printing in the Security Mode

This describes how to print in the security mode.

A Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

B The [Authentication] dialog box appears.

C Enter the Bluetooth password, and then click [OK].
As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label attached to the back of
the machine. For example, if the serial number is 00A0-001234, the Bluetooth
password is 1234.

D The print job is sent.

Note
❒ The Bluetooth password differs for each machine and cannot be changed.
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Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

Reference
For details about making option settings for the printer, see p.51 “If Bidirec-
tional Communication Is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check machine
status from your computer.
• Bidirectional communication is supported by Windows 95 / 98 / Me / 2000 /

XP, Windows Server 2003, Windows Vista, and Windows NT 4.0.
• If you use the RPCS printer driver and bidirectional communication is ena-

bled under Windows 2000, the [Change Accessories] tab is unavailable. 

Note
❒ The RPCS printer driver supports bidirectional communications and updates

the machine status automatically.
❒ The PCL printer driver supports bidirectional communications. You can up-

date the machine status manually.
To support bidirectional communication, the following conditions must be met:

❖ When connected with parallel cables
• The computer must support bidirectional communication.
• The machine must support bidirectional communication.
• The interface cable must support bidirectional communication.
• The machine must be connected to the computer using the standard paral-

lel cables and parallel connectors.
• Under Windows 2000, [Enable bidirectional support] must be selected, and

[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.
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❖ When connected with the network
• DeskTopBinder Lite must be installed, or the Standard TCP/IP port must

be used.
• Under Windows 2000/XP, Windows Server 2003, or Windows Vista, [Ena-

ble bidirectional support] must be selected, and [Enable printer pooling] must
not be selected on the [Ports] tab with the RPCS printer driver.

If the Standard TCP/IP port is not being used, one of the following conditions
must be met in addition to the two above:
• The SmartDeviceMonitor for Client port and the TCP/IP protocol must be

used.
• The standard TCP/IP port must be used without changing the default port

name (for Windows 2000 / XP, Windows Server 2003 and Windows Vista).
• Microsoft TCP/IP print IP address must be specified for use (for Windows

NT 4.0).
• When using IPP protocol with the PCL printer driver, the IPP port name

must include the IP address.

❖ When connected with USB
The machine must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

Note
❒ Install SmartDeviceMonitor for Client from the supplied CD-ROM.

If Bidirectional Communication Is Disabled

Set up option settings when bidirectional communications are disabled.

Important
❒ Under Windows 2000 / XP and Windows Server 2003, Manage Printers per-

mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] (Windows 2000) or [Printers and Faxes] (Win-
dows XP / Windows Server 2003) folder. Log on as an Administrators or
Power Users group member.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.
When using Windows XP or Windows Server 2003, point to [Settings] on the
[Start] menu, and then click [Printers and Faxes]. The [Printers and Faxes] win-
dow appears.
When using Windows Vista, click [Control Panel] on the [Start] menu, click
[Hardware and Sound], and then click [Printer]. The [Printers] window opens.
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B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Change Accessories] tab.
If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.
If you are using the RPCS printer driver, click the [Change Accessories] tab.

E Select options installed from the options area, and then make the necessary
settings.

F Select the total amount of the memory in [Total memory:] when the optional
SDRAM module is added.

G Under [Paper source tray settings:], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Do not use Auto Tray Select] check box to exclude the tray from the targets of
automatic tray selection.

H Click [OK] to close the printer properties dialog box. 
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Installing Font Manager 2000

Important
❒ Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, in-

stalling applications by Auto Run requires administrator permission. To in-
stall a printer driver by Auto Run, log on using an account that has
administrator permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Click [Font Manager 2000].

D Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5, 
or 7.0

Under Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, or Windows
NT 4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker
folder.
PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME\(Lan-
guage)\DISK1” on the CD-ROM.
The “WIN9X_ME” folder inside the “PS” folder is for Windows 95 / 98 / Me.
Use the folder at this level that is appropriate for the operating system you are
currently using.
The third folder “(Language)” may be substituted by an appropriate language
name.
Copy the .ppd file to the PageMaker folder.
• For PageMaker 6.0 default installation

The directory is “C:\PM6\RSRC\PPD4”.
• For PageMaker 6.5 default installation

The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

• For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

Note
❒ If the driver is not set correctly after copying the “.ppd” file, printing may not

be performed properly.
❒ When using PageMaker, the optional features that can be selected by the

printer driver will not be active. The following procedure describes how to
activate the optional printer features.
A On the [File] menu, click [Print].

The [Print Document] dialog box appears.
B Make the necessary settings in the [Features] box.
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Windows 95 / 98 / Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

DMake the necessary settings, and then click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application's own default settings are applied.

Reference
For details, see the printer driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.
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CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrator and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 
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Windows XP, Windows Server 2003 - Accessing the Printer 
Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
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Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
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C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Document Defaults...] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help. 
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Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 



Setting Up the Printer Driver

62

2

RPCS - Accessing the Printer Properties

Windows 95 / 98 / Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.
“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

❖ Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

❖ Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application's own default settings are applied.

Reference
For details, see the printer driver Help. 
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Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 
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Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 
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Windows XP, Windows Server 2003 - Accessing the Printer 
Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help. 

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 



Setting Up the Printer Driver

68

2

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the [Document Defaults...] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
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C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 
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3. Other Print Operations
71
Printing a PDF File Directly

You can send PDF files directly to the machine for printing, without having to
open a PDF application.

Important
❒ The function can be used with genuine Adobe PDF files only.
❒ This function supports version 1.3, 1.4, and 1.5 PDF files.
❒ PDF files created using the transparency function of PDF version 1.4 may not

be printed.
❒ PDF files created using Crypt Filter and/or the 16 bit colour image function

of PDF version 1.5 cannot be printed.
❒ PDF version 1.6 (Acrobat 7.0) files created without any functions that are ex-

clusive to PDF version 1.6 can be printed.
❒ Some types of High Compression PDF files may not be printed. Consult your

sales representative about the supported file types.

Note
❒ Paper size errors may occur when printing on custom size paper.

Printing Method

The following procedures explain the two methods of direct PDF printing - us-
ing Auto Document Link or by entering commands. 

Using DeskTopBinder Lite

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite.

A Quit all applications currently running.

B Insert the “Scanner Driver and Utilities” CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work under certain operating system settings. In this case,
launch “Setup.exe” located on the CD-ROM root directory.

C Select an interface language, and then click [OK].

D Click [DeskTopBinder Lite].
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E Follow the instructions on the display to install DeskTopBinder Lite.
If you are required to restart the computer after installing DeskTopBinder
Lite, restart the computer and continue the configuration.

DeskTopBinder Lite Enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files di-
rectly.

A On the [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features
Wizard].

BWhen [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Function2] screen appears.

C On the [Printing Function2] screen, click [Add...] to display [PDF Direct Print Prop-
erties].

D Select Driver for This Machine, click [OK], and then click [Next] repeatedly
until [Finish] is displayed.
Click [Finish].

Function Palette

The Function palette contains buttons for functions that are already configured
through DeskTopBinder Lite enhancement. Using these buttons, you can print
Windows files, preview printouts, convert images, and register scanners for doc-
uments without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the re-
quired function and dropping it there.

A On the [Start] menu, click [Programs], [DeskTopBinder], and [Function Palette].
An icon for the Function palette is added to the tasktray displayed at the bot-
tom right of the screen.

B Right-click the icon that is added to the tasktray, and then click [Properties]
to display the Properties screen.

C Click the [Contents] tab, select the [PDF Direct Print] check box at the centre,
and then click [OK].
The [Properties] screen closes and the [PDF Direct Print] icon is added to the pal-
ette.
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PDF Direct Printing

Use the method below to print PDF files directly.

A Drag the PDF file you want to print to the PDF Direct Printing icon in the
palette and drop it there.

B [Output File List-PDF Direct Print] is displayed.
Highlight the PDF you want to print, and then click [OK]. 
The PDF file is printed.

Printing PDF Password-Protected Documents

Follow the procedure below to print password-protected PDF files.

A In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extended
Features Wizard].

BWhen [Extended Features Wizard] appears, select [Start], and then click [Next].

C On the [Printing Function2] screen, click [Properties] to display [PDF Direct Print
Properties].

D Select the [Use PDF Password] check box at the bottom right of the screen, and
then click [OK].
Click [Next] repeatedly until [Finish] appears.
Click [Finish] to close the [Extended Features Wizard] screen.

EMove the PDF file you want to print to the PDF Direct Printing icon on the
palette using a drag-and-drop operation.

F [Output File List-PDF Direct Print] is displayed.
Select the PDF file you want to output to make it reverse video, and then click
[OK].

G The [PDF Direct Print Properties] screen opens.
Enter the password for the PDF file you want to print in the [PDF Password]
field at the bottom right of the screen, and then click [OK].
The password-protected PDF file is printed.

Note
❒ Before printing a password-protected PDF file, perform one of the following:

• Enter the PDF password in the PDF Direct Printing Properties screen.
• Specify a PDF password by selecting [Change PDF Password] in the [PDF

Menu] on the control panel of this machine
❒ If a [PDF Group Password] for the [PDF Menu] menu is assigned to either

DeskTopBinder Lite or the control panel of this machine, a same group
password needs to be assigned to the other.



Other Print Operations

74

3

PDF Direct Print Properties

1. Setting name:
Displays the plug-in configuration name
(up to 63 single byte characters)

2. Change Icon...
Changes the icon displayed on the tool
bar.

3. Printer:
Displays a list of RPCS drivers that sup-
port PDF direct printing.

4. Duplex
Prints on both sides of sheets.

5. Layout
Prints multiple pages on a single sheet.

6. Staple
Applies stapling to printout.

7. Display this dialog box before
printing
Appears in PDF direct printing mode if
this check box is selected.

8. Orientation
Specifies the original's orientation.

9. Number of copies
Specifies the number of copies to print.

10. Collate
Sorts printed sheets.

11. Range
Specify the pages you want to print.

12. Printout paper size
Specifies the size of the printout paper. 

13. Resolution
Specifies a print resolution.

14. PDF Password
If the PDF file is password-protected, en-
ter the password in this field. Otherwise,
the file cannot be printed.

15. Group Password
If a group password is assigned to Desk-
TopBinder Lite and this machine, enter
the group password in this field. Other-
wise, printing cannot start.

Using commands

You can print PDF files directly, using commands such as “ftp”, “sftp”, and
“lpr”.

Reference
For details about UNIX commands, see Network Guide and UNIX Supple-
ment.

BAE002S
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Unauthorized Copy Control

To prevent unauthorized copying, you can embed patterns and text beneath the
print. You do not need a special paper to use this function. If a paper with text
or image patterns is copied by a copier or a multi-function printer, either the pat-
terns are printed vividly or the copy is grayed out, so as to protect the informa-
tion on the original from leaking. To print with protection against unauthorized
copying, you can use [Data security for copying] and [Mask type:].

Important
❒ This function is designed to discourage copying of confidential documents; it

does not prevent unauthorized use of information.
❒ You must install the Copy Data Security Unit to gray out files protected by

Data Security for Copying that are stored in the document server or printed.
You do not have to install the unit to print files that are protected by Data Se-
curity for Copying.

❒ You can use this machine to print files that are protected by data security for
copying. However, because you cannot install the Copy Data Security unit on
this machine, copies of files cannot be grayed out when using data security
for copying.

❒ Data security for copying cannot be used together Toner saving. 
❒ Use the following setting to make the embedded pattern or text for prevent-

ing unauthorized copying more visible: 
• Under [Copier Features], [Original Type Setting], set [Original Type 1 (Text)] to

[Special Mode 1].
• Note that if you make this setting, gray-scale images in documents that do

not contain embedded patterns or text might not be copied properly.
❒ To use the Unauthorized Copy Control function, configure the RPCS printer

driver settings as shown below. This function cannot be selected if other set-
tings are applied.
• In the [Paper Type:] list, select [Plain/Recycled].

Opening the Unauthorized Copy Control Window

A In the RPCS printer driver, open the [Printing Preference] window.

B Click [Add/Change Custom Settings...].

C Select the [Unauthorized copy...] check box.

D Click [Control Settings...].
The Unauthorized Copy Control window appears.

Note
❒ For details, see the printer driver Help.
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Using [Data security for copying]

If a document printed with data security for copying is copied by or stored in the
Document Box of a copier or multi-function printer with the copy data security
unit, the copy or stored file is grayed out. This section explains how to specify
the printer driver setting for printing using [Data security for copying]. 

❖ Setting [Data security for copying] in the printer driver
• Select the [Data security for copying] check box. You can also enter the text in

the [Text:] box.
• You cannot select the [Mask type:] check box at the same time.
• To print a document protected by gray overprint, the machine must be set

up correctly. Consult an administrator.
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❖ Printing a document using [Data security for copying]

1. The pattern and text you have set
is printed.

2. The document is copied or stored
in copiers / multifunction machines
which the Copy Data Security unit is
installed.

3. The document is blanked by gray
overprint.

Note
❒ This machine can print only as described in Step 1.
❒ Only the RPCS printer driver is supported.
❒ You cannot partially embed a pattern and text in a document.
❒ Use 182 × 257 mm (71/4 × 101/2 in.) or larger paper.
❒ Use ordinary or recycled paper of at least 70% whiteness.
❒ Duplex printing may interfere with this function as a result of text and pat-

terns being visible through the paper.
❒ Printing with background patterns and text may be slower than normal print-

ing.

Reference
For details about setting [Data security for copying], see the printer driver Help.
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Using [Mask type:]

You can embed patterns and text in a document by setting in the printer driver
to prevent unauthorized copying.

❖ Setting [Mask type:] in the printer driver
• Select a pattern from [Mask type:], and then enter text in the [Text:] box.

Note
❒ You can set only [Text:], but [Mask type:] and [Text:] must be set together.
❒ To switch text and background patterns, select the [Reverse patterns:

text/background] check box.

❖ Printing a document using [Mask type:]

1. The pattern and text you have set
is printed palely.

2. The document is copied, scanned,
or stored in copiers / multifunction
machines.

3. The pattern and text you have set
appear clearly.

AJL031S
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Note
❒ Only the RPCS printer driver is supported.
❒ You cannot partially embed patterns and text strings in a document.
❒ To make the embedded pattern clear, set the character size at least 50 pt (pref-

erably 70 to 80 pt) and character angle to between 30 and 40 degrees.
❒ Due to the effects of the settings, the results of copying, scanning, and saving

documents in the document server may vary depending on the machine
model and setting conditions.

❒ Printing with background patterns and text may be slower than normal print-
ing.

Reference
For details about setting [Mask type:], see the printer driver Help.

Important Notice

• The supplier does not provide warranty regarding the appearance of print
patterns and other copy protection features. The appearance of the print pat-
terns and the performance of Unauthorized Copy Control may vary depend-
ing on the quality of paper used and the machine model and settings.

• The supplier takes no responsibility for any damages sustained in connection
with use of or inability to make use of Unauthorized Copy Control print pat-
terns.
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Form Feed

This section gives instructions for operating the machine when there is no tray
for the selected paper size or type, or when paper loaded in the machine has run
out.

Important
❒ The tray cannot be changed if the following functions are set:

• Duplex Print to a tray that does not support duplex printing
• Staple

Note
❒ If form feed is selected for a tray with the following settings, you can change

the tray by canceling the settings:
• Duplex Print
• Staple

❒ If [Auto Continue] is selected, form fed paper is printed after a set interval. See
“Printer Features”, General Settings Guide.

Printing from a Selected Tray

If the machine does not have a tray for the selected paper size or paper type, or
if the selected paper loaded in the machine has run out, a caution message ap-
pears. If this message appears, do the following procedure.

AWhen the caution message appears, press [FormFeed].

B On the confirmation screen, press {OK}.

If you want to stop printing, press [Cancel].
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C Select the tray for form feed using {T} or {U} from those that appear on the
display panel, and then press the {OK} key.
If you want to print after adding paper to the tray, select the tray after loading
the correct paper.

The machine prints using the selected tray.

Note
❒ If a tray with a smaller paper size is selected, the print job may be cut short,

or other problems may occur.

Canceling a Print Job

Follow this procedure for canceling the print job if the message prompting form
feed appears.

A Press [JobReset].

B Press [Current].

The confirmation message appears.
To cancel all jobs (current and queued), press [All Jobs].
To resume printing jobs, press [Resume].

C Press [Yes] to cancel the print job.

Press [No] to return to the previous display.
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Note
❒ If the machine is shared by multiple computers, be careful not to acciden-

tally cancel someone else's print job.
❒ Under Windows, If the machine is connected to the computer using a par-

allel cable, sent print jobs may be canceled if [JobReset] is pressed while
“Waiting...” is displayed on the control panel. After the interval set in [I/O
Timeout] in Printer Features has passed, the next print job can be sent. A
print job sent from a different client computer will not be canceled in this
case.

❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

❒ A print job containing a large volume of data may take considerable time
to stop.

Reference
For details, see p.83 “Canceling a Print Job”.
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Canceling a Print Job

This section gives instruction to stop printing from the computer or the control
panel.

Canceling a Print Job Using the Control Panel

A Press [JobReset] on the display panel.
A confirmation message appears.

B Press [Current].

To cancel all jobs (current and queued), press [All Jobs].
To resume printing jobs, press [Resume].

C Press [Yes] to cancel the print job.

Press [No] to return to the previous display.
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Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not com-
pleted.

A Double-click the printer icon on the Windows task tray.
A window appears, showing all print jobs currently queued for printing.
Check the current status of the job you want to cancel.

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing].

D Press the {Printer} key on the machine's control panel.

Note
❒ If the machine is shared by multiple computers, be careful not to acciden-

tally cancel someone else's print job.
❒ If the machine is connected to the computer using a parallel cable, sent

print jobs may be canceled if [JobReset] is pressed while “Waiting...” is dis-
played on the control panel. After the interval set in [I/O Timeout] in Printer
Features has passed, the next print job can be sent. A print job sent from a
different client computer will not be canceled in this case.

❒ In Windows XP, Windows Server 2003, Windows Vista, and Windows NT
4.0, click [Cancel] on the [Document] menu.

❒ In Windows 95 / 98 / Me / 2000 or Windows NT 4.0, you can also open
the print job queue window by double-clicking the machine icon in the
[Printers] machine window (the [Printers and Faxes] window under Win-
dows XP and Windows Server 2003, or the [Hardware and Sound] under
Windows Vista).

❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

❒ A print job containing a large volume of data may take considerable time
to stop.
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Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

Important
❒ The most recent 30 errors are stored in the error log. If a new error is added

when there are 30 errors already stored, the oldest error is deleted.
❒ If the main power switch is turned off, the log is deleted.

A Press the {Printer} key to display the Printer screen.

B Press [Menu].

C Select [Error Log] and then press the {OK} key.

D Select the error log you want to check using {T} or {U}, and then press the
{OK} key.

A detailed error log appears.

Note
❒ Press the {Escape} key until the Printer screen appears after checking the

log.
❒ To print files that appear in the error log, resend them after stored files

have been printed or deleted.
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Printing with the Finisher

You can collate or staple by installing the optional finisher. Make sure you read
the following precautions when using the optional finisher.

Important
❒ Make option settings for the machine using the printer driver when bidirec-

tional communication is disabled.
❒ Be sure to set the paper size and paper orientation in the printer driver when

using duplex printing, combined printing (layout) and staple functions.

Note
❒ Depending on the application, print settings may not be enabled and printed

output may not be as expected.
❒ When setting Staple or Collate in the printer driver, make sure that the Collate

check box is cleared in the application's [Print] dialog box. If Collate is enabled
in the application, printing will not be as intended.

❒ When printing restarts after removing jammed paper, the printing position
may be different, depending on the location of the jam.
• If the paper jam occurred in the optional finisher, printing will restart from

the top page of the data currently being printed, or from the page where
the paper jam occurred.

• If the paper jam occurred in the machine, printing will restart from the
page where the paper jam occurred.

• Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.

Reference
For details about duplex printing, or combined printing (layout), see the
printer driver Help.
For information about optional finisher, see About This Machine, General
Settings Guide and Copy Reference.
To remove paper misfeeds, see Troubleshooting.



Collate

87

3

Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer to the printer memory. The following are the three
types of Collate:

Important
❒ If Auto Continue occurs on the first set, Collate will be canceled.
❒ If forced printing occurs on the first set, Collate will be canceled.
❒ When setting Collate in the printer driver settings, make sure that a collate

option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

Note
❒ Set Collate and Rotating collate when using the RPCS printer driver.
❒ Follow the procedure below when using the printer driver other than the

RPCS:
• Set Collate and Rotating Collate in the printer driver.
• If you cannot make Shift Collate even with the optional finisher installed,

options may not be set up correctly in the printer driver. Correct the printer
driver's option settings.

• For details, see the printer driver Help.

Collate

Printed output is assembled as sets in sequential order.

AEU016S



Other Print Operations

88

3

Rotating Collate

Every other print set is rotated by 90 degrees.

Important
❒ The Rotating Collate function requires two paper trays containing same size

paper but in different orientations.
❒ If the output tray has shift function, Shift Collate will be applied even if Ro-

tating Collate is selected.
❒ If a document with mixed paper sizes or sizes larger than A4, 81/2 × 11 is set,

it can only be collated, even if Rotating Collate has been selected.

❖ When Rotate Collate is cancelled
If the following functions are selected, Collate or Shift Collate will be applied
even if Rotating Collate is selected:
• When combined with staple function.
• If jobs containing pages of various sizes are set.
• If custom size paper is set.

Note
❒ When Rotating Collate has been selected, printing speed will be slower than

with other collate functions.
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Shift Collate

The optional finisher is required for this function.
The finisher shift tray moves backward or forward when a job or set is output,
causing the next to shift, so you can separate them.

Important
❒ This function is not available when you select the following paper type;

• Label paper
• OHP paper

Note
❒ If you select the thick paper in this function, the paper is delivered to the Fin-

isher shift tray.

Reference
For details about paper sizes and the number of sets you can use Collate or
Rotating Collate with in every option, see Copy Reference. For details about
printing methods, see the printer driver Help.
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Staple

With the optional finisher sets can be stapled individually when printing multi-
ple sets.

Staple Position

The specified staple position varies depending on paper size, type, quantity and
feed orientation. The following table shows staple positions:

Note
❒ Stapling might not be in the specified position if combine (layout) and duplex

printing are both selected. After setting the staple position, use the printer
driver's preview icon to check the position before printing.

Reference
For paper sizes and maximum numbers of sheets available for stapling, see
“Specifications for Options”, About This Machine.
For details about the types of paper that can be used with the stapling func-
tion, see “Supplementary Information”, Copy Reference.
For printing methods, see the printer driver Help.

AYM001S
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Stapling Precautions

Important
❒ Stapling can be done only with the optional finisher installed.

❖ Staple printing will be canceled under the following conditions:
• If the number of pages to staple exceeds maximum.
• If a paper size that cannot be stapled is selected.
• If a paper type that cannot be stapled is selected.
• If positions other than those fixed for stapling are specified.
• If there are inconsistencies between the orientation in the duplex mode and

the staple position.
• If there are inconsistencies between the orientation in letterhead mode and

the staple position.
• If paper sizes are mixed when a different paper size is specified during a

print job.
• When feeding paper from the bypass tray.
• When combined with Rotating Collate.
• When staples have run out and Auto Continue is set (printing will contin-

ue without stapling after the message has been displayed).
• When only 1 page is printed.
• When staples have run out.

Note
❒ When the stapling is cancelled, “Staple Cancelled” appears.
❒ If Staple is selected with the optional finisher installed, the paper will be out-

put to the finisher shift tray irrespective of the setting.
❒ When printing on letterhead, stapling may not be at the specified position.
❒ If you cannot make staple settings even with finisher installed, options may

not be set correctly in the printer driver. Correct option settings in the printer
driver. For details, see the printer driver Help.

❒ When the finisher is being used for another function's job (for example, a copy
job), printing will start after that job ends.

❒ Be sure to set paper size and orientation in the printer driver when stapling.
❒ When duplex printing is selected, adjust staple positions to the binding orien-

tation.
❒ Depending on the software you are using, print settings may not be saved

and the printed result may not be as expected.
❒ When setting Staple in the printer driver settings, make sure that a collate op-

tion is not selected in the print settings of the application. If a collate option is
selected in the application, printing will not be as intended.
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4. Appendix
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Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

Component Specifications

Resolution 600/300 dpi

Printing speed 25 ppm

(A4K, 81/2 × 11 K plain paper)

Interface Standard:

• Ethernet interface (100 BASE-TX / 10 BASE-T)

• USB 2.0 interface

Option:

• IEEE 1284 parallel interface
Use a standard 36-pin printer cable not longer than 3 meters (10 feet).

• IEEE 802.11b wireless LAN interface

• Bluetooth interface

Network protocol TCP/IP, IPX/SPX, AppleTalk

Printer language Standard: RPCS, PCL 5e, PCL XL

Option: PostScript 3, PDF

Fonts PCL XL/5e :

Monotype Imaging 35 Intellifonts, 10 TrueType fonts, 13 Interna-
tional fonts, and 1 Bitmap font.

PostScript 3 :

136 fonts (Type 2:24, Type 14:112)

Memory 384 MB

Network cable 100 BASE-TX / 10 BASE-T shielded twisted-pair (STP, Catego-
ry/Type5) cable.

USB Interface (Standard) • Supported Operating System:
Windows Me / 2000 / XP, Windows Server 2003, Windows Vis-
ta, MacOS 9.2.2, MacOS 10.3.3 or later

• Transmission spec.
USB 2.0 Standard

• Connectable Device:
Devices corresponding to USB 2.0 Standard
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Note
❒ When using MacOS, use only the standard USB interface. The optional USB

interface board is not supported.
❒ When using the USB Interface (Standard) with MacOS 9.2.2, only USB 1.1 is

supported.
❒ When using the USB Interface (Standard) with Windows Me, install USB

Printing Support. Windows Me only supports USB 1.1 speed.

Options

Important
❒ The IEEE 802.11b interface unit, the IEEE 1284 interface board, and Bluetooth

interface unit cannot be installed concurrently.

IEEE 1284 Interface Board Type A

❖ Transmission spec.:
IEEE 1284

❖ Required cable:
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

IEEE 802.11b Interface Unit Type H

❖ Transmission spec.:
Based on IEEE 802.11b (wireless LAN)

❖ Protocol:
TCP/IP, IPX/SPX, AppleTalk

Note
❒ SmartDeviceMonitor and Web Image Monitor are supported.

❖ Data transfer speed:
Auto select from below speed
1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

❖ Frequency range:
• Inch version:

2412 - 2462 MHz (1 - 11 channels)
• Metric version:

2412 - 2472 MHz (1 - 13 channels)
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❖ Transmittable distance:
1 Mbps 400 m
2 Mbps 270 m
5.5 Mbps 200 m
11 Mbps 140 m

Note
❒ These figures are a guideline for outdoor use. In general, the transmittable

distance indoors is 10 - 100 m, depending on environment.

❖ Transmission mode:
Ad hoc, and infrastructure mode

Bluetooth Interface Unit Type 3245

❖ Supported Profiles:
• SPP (Serial Port Profile)
• HCRP (Hardcopy Cable Replacement Profile)
• BIP (Basic Imaging Profile)

❖ Frequency Range:
2.45 GHz ISM band

❖ Data Transmission Speed:
723 kbps

Note
❒ The transmission speed is adjusted according to factors such as the dis-

tance and obstacles between the devices, radio signal condition and Blue-
tooth adaptor.

❖ Maximum Range:
10 m
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Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.

PCL® is a registered trademark of Hewlett-Packard Company.

Monotype is a registered trademark of Monotype Imaging, Inc.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and True Type are trademarks of Apple Inc, regis-
tered in the U.S. and other countries.

BonjourTM is a trademark of Apple Inc.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.

NetWare is a registered trademark of Novell, Inc.

UPnP is a trademark of the UPnP Implementers Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows® 95

• The product name of Windows® 98 is Microsoft® Windows® 98

• The product name of Windows® Me is Microsoft® Windows®  Millennium Edition (Windows Me)

• The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

• The product names of Windows XP are as follows:

Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Media Center Edition

Microsoft® Windows® XP Tablet PC Edition

• The product names of Windows Vista are as follows:

Microsoft® Windows VistaTM Ultimate

Microsoft® Windows VistaTM Enterprise

Microsoft® Windows VistaTM Business

Microsoft® Windows VistaTM Home Premium

Microsoft® Windows VistaTM Home Basic

• The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

Microsoft® Windows Server® 2003 Web Edition

Microsoft® Windows Server® 2003 Datacenter Edition

• The product names of Windows NT 4.0 are as follows:

Microsoft® Windows NT® Workstation 4.0

Microsoft® Windows NT® Server 4.0
Copyright © 2007
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